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What this exercise is about
The objective of this lab is to provide you with an understanding of how to mediate an unmodeled fault within a
mediation flow. Unmodeled faults occur for faults that are not defined in the WSDL interface. This lab will

show you how to handle any faults that are not explicitly defined in the WSDL interface. You will create a
mediation module to handle them and mediate them within a mediation flow component.

Lab requirements
List of system and software required for the student to complete the lab.
e Web Sphere Integration Developer V6.1 installed

e Web Sphere Enterprise Server Bus V6.1 test environment installed

What you should be able to do
At the end of this lab you should be able to:

« Import the project interchange file into the Web Sphere Integration Developer V6.1 development
environment

e Create and edit a mediation module and mediation flow
* Wire the new fail terminals in the Callout Response nodes to mediation primitives

e Test the unmodeled fault using the Web Services Explorer.
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Introduction

This lab demonstrates the ability to mediate modeled and unmodeled faults within a mediation flow. It focuses
particularly on the ability to route the two different types of faults (modeled and unmodeled) to the appropriate
flow within the mediation flow component.

In this lab, the mediation flow will call an existing Web service through a Web services import binding. The
Web service returns stock prices for a particular stock symbol and creates a fault message if the stock symbol
is not known. This particular fault message is modeled in the WSDL interface. To create an unmodeled fault,
the mediation flow is run with a stock quote symbol that contains characters which are not valid, for example,

#@.!.

The Web service interface and business objects are shown below:

e The StockQuoteService provides these operations:

{ L

getDelayedQuote — accepts a stock symbol, and returns a cached stock quote, which expires in

10 minutes.

getRealTimeQuote — accepts a stock symbol, and returns an instance quote from Yahoo stock

guote service.

0Operations

E% VP B

Cperations and their parameters

| Marne Type
v%“ggetDelavedQuute
L+ Inputis) symbaol skring
L Cutpuk(s) getDelayedQuoteReturn Float
[x] Faulks) UnknownSymbolE:ception UnknownSymbolException
v%@getRealTimeQuute
L Inputis) symbol skring
[E» Cukpuk(s) getRealTimeQuoteReturn Float
[x] Faultis) UnknownSymbolException Unknown3ymbolException

< Inthe event when an unknown symbol is received, an UnknownSymbolException business exception is
returned as a WSDL fault

2008 May, 12

= [2] UnknownSymbolEception

message skring

IBM WebSphere Enterprise Service Bus 6.1 — Lab exercise

WESB UnModeledFaults Lab

Page 3 of 34



© Copyright IBM Corporation 2008. All rights reserved

e Avalid stock symbol must begin with a character from a through z or A through Z, inclusive. Otherwise,
a BadSymbolException is thrown by the operation. However, this exception is not defined in the Web
service interface.

You will create a mediation flow that adds a custom mediation to each of the response flows in order to dump
the Service Message Object (SMO) that is passed in so that each one can be inspected. In the case of the
non-fault case, after printing out the SMO, the message is passed back as the input response.

In the case of the modeled fault, the flow will pass the message back to the callout fault node. Finally, in the
case of the unmodeled fault flow, the message is silently stopped by way of a Stop primitive. Another option
that might be used is to use the Event Emitter primitive rather than the Custom Mediation primitive used here.

Exercise instructions

Some instructions in this lab might be Windows operating system specific. If you plan on running WebSphere
Integration Developer on a Linux operating system you will need to issue the appropriate commands and use
appropriate files for Linux. The directory locations are specified in the lab instructions using symbolic
references, as follows:

Reference Variable Windows Location AIX®/UNIX® Location
<WID_HOME> C:\Program Files\IBM\WID61 /opt/IBM/WID61
<ESB_PROFILE_HOME> | <WID_HOME>\pflesh <WID_HOME>/pflesb
<LAB_FILES> C:\Labfiles6 1\WESB\UnModeledFaults /tmp/Labfiles61/WESB/UnModeledF

aults
<WORKSPACE> C:\Labfiles61\WESB\UnModeledFaults\w | /tmp/Labfiles61/WESB/UnModeledF
orkspace aults/workspace

Windows users’ note: When directory locations are passed as parameters to a Java" program such as
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java
convention. For example, C:\LabFiles61\ should be replaced by C:/LabFiles61/

Note that the previous table is relative to where you are running WebSphere Integration Developer. This table
relates variables to where you are running the remote test environment:
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<SERVER_NAME> serverl sssr011

<WAS_HOME> C:\Program letc/sscell/AppServer
Files\IBM\WebSphere\AppServer

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com

<SOAP_PORT> 8880 8880

<TELNET_PORT> N/A 1023

<PROFILE_NAME> AppSrv0l default

<USERID> N/A ssadmin

<PASSWORD> N/A frlday

Instructions for using a remote testing environment, such as z/OS, AIX or Solaris, can be found at the end of
this document, in the section ‘Task: Adding Remote Server to WebSphere Integration Developer Test
Environment'.

2008 May, 12 IBM WebSphere Enterprise Service Bus 6.1 — Lab exercise Page 5 of 34

WESB UnModeledFaults Lab



© Copyright IBM Corporation 2008. All rights reserved

Part 1: Set up development environment

In this section of the lab, all the projects that are part of the WESB_UnModelledFaults_Pl.zip project
interchange file are imported into a new workspace. There are three projects that are imported.

1. Start WebSphere Integration Developer V6.1 with a workspace location of

<LAB_FILES>\WESB\UnModeledFaults\workspace
= Workspace Launcher
Select a workspace

IEM WebSphere Inteqgration Developer 6,1 skares wour projects in a Folder called a workspace,
Choose a warkspace Folder ko use Faor this session,

Wiorkspace: IC:'l,LaI:uFiIesEu1'l,'u'-.-'ESB'l,UnM-:udeIedFauIts'l,wu:urkspau:e j Browse, ., |

[ Use this as the default and do not ask again

: Zancel |

___a. On the welcome screen, click the curved arrow at the top right to Go to the business
integration perspective (LI

), to close the Welcome window

2. Import the Project Interchange file, WESB_UnModeledFaults_Pl.zip, into the development

environment

___a. Right-click inside Business Integration View (top left view in the Business Integration
Perspective)

___b. Select Import from the pop-up menu
| Business Integration X =0
= EE‘IE oy | ==

Rlew k
Dpen

oy
. Paste

X Celete

Build Path »

|

£ Expart...

2| Refresh

Properties
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___c¢. From the Import dialog, expand ‘Other’ and select Project Interchange from the list.

___d. Click Next

___e. Click the Browse button for ‘From zip file’ to navigate for the Project interchange file,
WESB_UnModeledFaults_Pl.zip

4= Import Project Interchange Contents E
Import Projects =i

Import Projects from a zip file. I |

- |
From zip file: IC:'l,LaI:uFiIesEu1'I,'-.-'-.-'ESB'I,LInMcu:IeIedFauIts'l,imp-:urt'l,'-.-'-.-'ESB_LlnM-:udeledFauIts_F‘I.zip j Browse. ., |
Praojeck lacation roak: | C:iLabfiles6 1\WESB URMadeledFaultshworkspace Browse, ., |

= DurmpLtils
= StockQuoteServiceEAR
= StockQuoteServiceWWeb

Deselect all | Seleck Referenced

(2) < Back et = || Firish I Cancel

___f. Click the Select All button to ensure all projects listed are selected

___@. Click the Finish button (projects are imported and auto-build will run)
___h. Verify that DumpUitils, StockQuoteServiceEAR and stockQuoteServiceWeb have been imported

| Business Integration X =0

= EE‘IEQ?H ==

L= Dumpltils |

%- StackQuateServiceEAR
:j'.‘l StockQuoteServicedieb

3. Verify that the ‘WebSphere ESB Server v6.1' is listed in the Servers view

' p s
Build &ctivities | Properties | Problems m\tunsule s ) G /e | = =0

Server Status Ztate
¢2 wWehSphere ESE Server va. 1 Ei:.; Skopped Republish
H WebSphere Process Server wé,1 g Stopped Republish
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Part 2: Create mediation module

In this section of the lab, a new mediation module is created. There can only be one mediation module for
each deployable project.

1. To create the mediation module, complete these steps:

__a. Inthe Business Integration view, right-click and select New - Mediation Module from the pop-
up menu. The new Mediation Module wizard opens

__b. Inthe New Mediation Module wizard, type the Module Name as UnModeledFaultTest

___c. Verify that the target runtime is the WebSphere ESB Server v6.1 and clear the ‘Create
mediation flow component’ check box

= New Mediation Module
Mediation module

Tl
Create a new mediation module, & mediation module is a project that is used for |
developrient, version management, arganizing resaurces, and deploying to the

Maodule name: ILInMDdEIEdFauII:Test —

¥ Use default location

Locakion: | i JLabfilesal MWESEUnModeledFaults workspace UnModeledF. Browse. .. |

Targek runkime: I'-.-'-.-'el::Sphere ESE Server vo,1 ==— j

[l- é;__reate mediakion compaonent;

I arne; IUnMDdeIedFauItTest

Mediation modules can be deploved and run on WebSphere Enterprise Service Bus or
WebSphere Process Server, They contain Flows, which link together operations For modifying
and routing messages between service consumers and service providers.,

(7) Finish I Cancel

___d. Click Finish

___e. A mediation module named UnModeledFaultTest is created. (You will create the mediation flow
component later.)

2. The Dump Utility that is used needs to be added as a dependency to the mediation module.

___a. Inthe Business Integration view, expand UnModeledFaultTest module you just created and
CHO S T
double click ‘Dependencies’ (== Matahuabs=

) to open the dependency editor
___b. In the Dependencies Editor, expand the ‘Java’ section and click the Add... button.
___c. Inthe Java Project Selection dialog, select DumpUtils and click OK

___d. Press Ctrl+S to save the dependencies for this module.

___e. Close the Dependencies editor.
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Part 3: Import Web service interface

In this section of the lab, the interface to the StockQuoteService is imported into the UnModeledFaultTest
Mediation Module Project. It is in the form of a .wsdl file that defines the service is used along with the

operations it exposes.
1. Toimport the Web service interface, complete these steps:

___a. Inthe Business Integration view, right-click the UnModeledFaultTest mediation module and
select Import... from the pop-up menu. The ‘Import’ wizard opens

___b. Inthe ‘Import’ wizard, expand ‘General’ and select File System and click Next
___c. Inthe ‘File system’ panel, click the Browse button for ‘From Directory’ field, to file system
1) Select<LAB_FILES>\import and click OK on the ‘Import from directory’ panel

2) Select the check box for StockQuoteService.wsdl

= Import
File system F—
Import resources From the local File system. t"" f;
4
From direckory: IC:'l,LaI:uFiIesEu1'l,'-.-'-.-'ESEi'l,LInMu:u:IeIe-:IFaults'l,impu:urt j Browse, ..

[ = import DumpLtilSniopet bt

WESE_LInModeledFaults_PI_solution, zip
O &3 wesE_UnModeledFauls_PLzip

Filter Types. .. | Select Al Deselect Al |

Into Folder: I IInfModeledFault Test Browse, .,

Options
| Cverwribe existing resources without warning

" Create complete folder struckure

¥ Create selected Folders only

(7] < Back [exk = | | Firish I Zancel

___d. Click Finish.

2008 May, 12 IBM WebSphere Enterprise Service Bus 6.1 — Lab exercise Page 9 of 34

WESB UnModeledFaults Lab



© Copyright IBM Corporation 2008. All rights reserved

Part 4: Create the mediation flow

In this section of the lab, you will create the Mediation Flow. Once the operations are wired together, some
mediation primitives are added for the new unmodeled fault flow in the mediation flow component. Custom
Mediations are added to the various flows to dump the messages and inspect their contents.

1. To create the mediation flow, complete these steps:

___a. Inthe Business Integration view, expand ‘UnModeledFaultTest’ mediation module, right-click on
‘Mediation Logic’ and select New - Mediation Flow from the pop-up menu

= B
= EEIE‘EJ == S

Business Integration M

-1z Dumpltils
% StockQuoteServiceEAR
fjj- StockQuoteServiceWeh
El@ UnModeledFault Test
5] Assembly Diagram
- i
g Cependencies

@ Mediation Flow

Paste =

___b. In the New Mediation Flow panel, enter the Name as UnModeledFaultTestFlow

4= Mew Mediation Flow
Create a new mediation flow . o |
5,
Maodule: ILInMn:u:IeIedFauItTest j Browse, ., | Mew, |
Mamespace: I http:/flUnModeledFault Test/UnModeledFault Tes IV Default
Faolder; | Browse, |
Mame: | UnModeledFault TestFlow
(7) = Back Finish | Cancel
___C. Click Next

___d. Inthe ‘Creating a new interface’ panel, add the source and target interfaces

1) Click the Add button next to the Source interfaces text area and select
‘StockQuoteService’ from the Interface Selection pop-up window
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- New Mediatic = Interface Selection H[=]

Creating a ne

Filter by interface or qualifier {7 = any characker, * = any String):
Select source and

L |
[ -

—Source inkerfan Matching interfaces:

Remove

— Target inkerfac:

Add

t:

- Remove
Qualifier: =

@http:,l',l'example.mm - UnModeledFaultTest i StockQuoteSeryic

II:?:' \2) e I Cancel | Cancel |

2) Click OK over the Interface Selection pop-up window

3) Similarly, click the Add button next to the Target interfaces text area and select
‘StockQuoteService’ from the Interface Selection pop-up panel

4) Click OK over the Interface Selection pop-up panel
5) The added source and target interfaces should look like in the picture shown below:

4= New Mediation Flow
Creating a new interface

Select source and karget interfaces,

—Source inkerfaces

{http: ffexample. com}tStockQuoteService

Remove

il ¢

Target inkerfaces

{http: ffexample. com}-StockQuoteService

Remove

L7 < Back, Mexk = Einish | Cancel |

6) Click Finish
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___e. Upon creation of the UnModeledFaultTestFlow Mediation Flow, it is opened in the Mediation
Flow Editor as shown in the picture below:

s
?8] UniModeledFaultTest - Assembly Diagram s Mediation Flow Editor: UniodeledFault TestFlow

- @ UnfodeledFaultTest  * {ﬁ_&} UnfModeledFaultTestFlow ':i:' StockQuoteService ® %@ getDelayved @ 5':'

+(0peration connections @ 4';—;| éﬁ
Select a source operation, conneck ik ko one or maore target operations, and define the mediation Flow.
(:E} StockQuoteservice StockQuoteServicePartner
%g getDelayedfuote %@ getDelavedJuote
%@ getRealTimeQuote %@ getRealTimeJuoke
Fa.
1 ——Palette — 4
NeE I o
=% =%
- Input Input Response

ol ites getDelayvedQuote, .. getDelayvedQuote, .

[~ TransFormation

[.—= Riouting

_ th

L Tracing Input Faulk

L= Error Handling StackQuaoteService

—I E';; Request: getDelayedQuote

Create a request flow:

To create the request flow, complete these steps:

2. Inthe ‘UnModeledFaultTestFlow’ mediation flow editor, connect the source to target operations in
the Operation Connections view

___a. Click anywhere on the source operation, StockQuoteService/getDelayedQuote on the left side
of the Operation Connections view

(T) StockQuoteService

%‘@ getDelayedQuote
2 getRealTimeQuate

|Create Operakion Cu:unneu:tiu:un|

___b. Drag to the target operation, StockQuoteServicePartner/getDelayedQuote on the right side of
the Operation Connections view and release the mouse click

Alternative: Right-click on the source component, StockQuoteService/getDelayedQuote and select
Create an operation connection and then click on the target operation,
StockQuoteServicePartner/getDelayedQuote

(:E} StockQuoteService StockQuoteServiceParkner
%@ getDelayedQuote - %@ getDelayedQuote
% getRealTimeQuote 2 getRealTimeQuote
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___C. Click on the black arrow (wire) to view the Mediation Flow View and ensure the Request tab is
selected to build the Request flow

3. Drop a Custom Mediation primitive to the un modeled fault Response Flow canvas
__a. Connect the getDelayedQuote Input to the getDelayedQuote Callout. Click on the output

terminal of the Input Request for getDelayedQuote and drag a wire to the input terminal of the
getDelayedQuote Callout

1 —Palette — - : 1
I &= % L

- Inpuk Callaut
E Fawr::tes getDelayedfuate. .. getDelayedQuate...

Transrormation
[~ Reouking DI}
[~ Tracing Input Response
|.— Error Handling getDelayedQuate. ..
0
Input Faulk

SkackQuokeService

ﬂLEE';. Request: getDelayvedQuote | o= Response: getDeIayedQuute|

___b. Select the Response Tab in the Mediation Flow diagram (middle view) to see details of the
Response flows. Notice the new terminal that is used for the unmodeled fault, highlighted below
with the red oval

1 —Palette — ] 4
|E (#] (=) ) bl

_ Callout Response C:) Input Response
= il getDelayedQuote, ., getDelayedQuote, .,
[~ Transformakion Fail:

: getDelavedQuaokeR equest
Raoutin

iad 21110 P ®H
L— Tracing Callaut Fault Input Fault
L.— Errar Handling StockuoteServic.., StackOuoteService

| L. Request: getDelayedQuate lq{EJ Response: getDeIayedQunteJ

___c. Inthe Mediation Flow Editor(middle view), click the Custom Mediation icon

(CUStDm Mediation) to select the Custom Mediation primitive from the transformation palette tray
on the left side. Then drop it into the canvas between the Callout Response node and the Input
Response Node
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1 —Palette — 4

|E L‘i‘.{. Lf.,," EE' 5[}
_ Callout Response .

[.— Faworites qetDelayedQuots. .. npukt Response
[~ TransFormakion =E— CustomiMediakionl getDelayedQuate. ..
Cuskarm Mediatiun] e

— o

|| Database Lookup Callout: Fault L 153

[i] Message Element ... | skacknuoteServic. .. Input Fault

-~ Business Ohject Map StockGuoteService
.FE-: Set Message Type

-
| E';; Reguest: getDelayedQuote ¢'E-| Response: getDelayedQuote |

___d. Select the Details tab in the ‘Properties’ view (bottom window) of the CustomMediationl

2
Build Activities Prnblems|5&rvers| =0

Description Custom Mediation : CustomMediation] ==——

Terminal

Liser Properties Irnplementation: ) Eisual

Detalls &
Java Imporks * - DO NOT MODIFY

llf'ﬂ"k -

Promoted Properties * Variasbhles: for output terminals - out (o, ibm.wsspil.sikbx.mediation.
* for user properties - «<No user properties defined:>
* Inputs: inputTerminal (com.ibm.wsspi.sibx.wediation. InputTerminal
* Exceptions: com.ibm.wsspi.sibx.mediaction.MediationConfigurationExcept
o

out.fire (sma) ;

___e. A'DumpUtility’ was included in the Project Interchange file first imported. Call it from the
CustomMediationl to dump the contents of the Service Message Object (SMO). To do this,
add following code to the ‘Java’ implementation section of CustomMediation1:

dumpUtils._DumpDataObject dumper = new dumpUtils._DumpDataObject();
dumper .dumpDataObject(smo, "Un-Modeled Fault Taken™);

out.fire(smo);

A generic form of this code that can be cut and pasted and edited is included in this file:
<LAB_FILES>\import\DumpUtilSnippet.txt

<
Build Activities Pru:ul:ulems|53rvers| =¥ =0

Diescription Custom Mediation : CustomMediationl
Terminal
User Properties Implementation: ) Yisual [ &
Details - dumpUtils. Dunplbatadbject dummper = new dumpUtils.Dwunpbatachiject () ;
Java Imports durnper . dumplatathiect (smo, "Un-Modeled Fault Taken'™) :
Promoked Properties out.fire(smo) ;
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__f. Drop a Stop Mediation primitive Response Flow canvas. Click the Stop icon (EI St':'F') to select
the Stop primitive from error handling palette tray on the left side and drop it into the right of
CustomMediationl primitive as shown below:

1 — Palette —
s = EL i o
[.— Favorites Callout Response Input Response
[~ Transformakion getDelayedQuote, ., getDelayedQuote, ..
|~ Routing =
[~ Tracing CustomMediationl Jtopl
[~ Error Handling =es— 29

Fail Input Fault
e StockQuoteService

Ca"l:ll..ltoFaLﬂt
StockouoteServic, .,

| . Request: getDeIayedQuute” = Response: getDeIayedQuutel

___@. Click on the fail terminal of the Callout Response for getDelayedQuote and drag a wire to the
input terminal of the CustomMediationl primitive

! A
Calluutﬁspnnse Inpuk Eipnnse
getDelayedQuote, .. getDelayedCuote. ..

B
CustormMediation Stopl

___h. Wire the output terminal of CustomMediationl to the input terminal of the Stop1 primitive

; §
Calluutﬁspnnse Input Egspnnse
getDelayvedQuote, .. getDelayedQuate. .,

=
CuskomMediation1 Stopl

4. Specify that the original request message should be included when an unmodeled fault is taken.
___a. Select the getDelayedQuote Callout Response.
___b. Select the Details tab in the properties view for getDelayedQuote.

___C. Select the check box for ‘Include the original request Message’ to indicate the complete
message should be propagated to the fail terminal in the event of a failure
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Build Activities Problems | Servers ¥ =0

Callout Response : getDelayedQuote : StockQuoteServicePartner

o

Description

Terminal

[Details e Feference name: |StockQuokeServicePartner
Promoted Properties Cperation name: | getDelayeduoke

[ Include the original request messageé]

5. Add a Custom Mediation primitive to the modeled fault Response Flow canvas

___a. Ensure the Response tab is selected. Click the Custom Mediation icon (‘:'-'5“3"'n Mediation)) jn
the transformation palette tray (left-hand side) and then click to the right of the Callout Fault
terminal (the modeled fault) as shown below:

1 —Palette —
T @ CL 9 b

|~ Favarites allout Response Input Response
= Transformation getDelayedQuote, ., getDelayedQuote, ..
[ Cushkam Mediatil:unl =

| | Database Lookup CustomMediation1 Stopl

%) Message Elemert: ... 00

E" Business Cbject Map Inpljt Fault

1], Set Message Type ' ' StockuokeService

#5L TransFormation ]

Callout Fault o CustamMediationz
StockQuokeServic, ..

| L. Request: getDelayedQuate | & Response: getDelaveduote

___b. Select the CustomMediation2 primitive and then the Details tab in the properties view.

___c. Call the ‘DumpUtility’ from the CustomMediation2 to dump the contents of the Service Message
Object (SMO). To do this, copy and paste this Java snippet to the ‘Java’ implementation text

area

dumpUti Is_.DumpDataObject dumper = new
dumpUti Is.DumpDataObject();
dumper .dumpDataObject(smo, ""Modeled Fault Taken'™);

out.fire(smo);
A generic form of this code that can be cut and pasted and edited is included in this file:

<LAB_FILES>\import\DumpUtilSnippet.txt
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2
Build Activities Pru:ul:ulems|53rvers| ¥ =0

Description Custom Mediation : CustomMediation2

Terminal

User Properties Implementation: O visual| @ ;

Details — ae—r durpUtils. Dumplatathiect dutper = new durmpUtils.DunpDatachiect () ;
Java Imports dumper . durplbatachiject (smo, "Modeled Fault Taken™):

Promoted Properties out.fire (smo) ;

___d. Click on the output terminal of the Callout Fault of StockQuoteServicePartner and drag a
wire to the input terminal of the CustomMediation2 primitive

1
Input Faulk
StockQuoteSeryice
>t
Callout Fault CustomMediationz
StockQuoteServic, ..

___e. Click on the output terminal of the CustomMediation2 primitive and drag a wire to the input
terminal of the StockQuoteService Input Fault

t
Input Faulk
StockQuoteservice
DY
Callout Fault CuskomMediation?
StockQuoteServic, ..

6. Add a Custom Mediation primitive to the non-fault Response Flow canvas

__a. Ensure the Response tab is selected. Click the Custom Mediation icon (':'-'St':Im Mediation) jn
the transformation palette tray (left-hand side) and then click to the right of the Callout
Response output terminal as shown below:

n n
2 o
Callout Response _CustomMediationa, Input Response
gethelayedQuate. .. getDelayedCuate. ..
@2 =
CustomiMediation] atopl

___b. Select the CustomMediation3 primitive and then select the Details tab in the properties view.
___c. Call the ‘DumpUitility’ from the CustomMediation3 to dump the contents of the Service Message
Object (SMO). To do this, copy and paste this Java snippet to the ‘Java’ implementation

dumpUtils._DumpDataObject dumper = new
dumpuUtils.DumpDataObject();

dumper .dumpDataObject(smo, "Successful Response™);
out.fire(smo);
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A generic form of this code that can be cut and pasted and edited is included in this file:
<LAB_FILES>\import\DumpUtilSnippet.txt

o
Build Activities Pru:ul:ulems|53rvers| ¥ =0

ST Custom Mediation : CustomMediation3
Terminal
User Properties Implementation: O yisual &1

Details durmpUtils. DumpbataCkhject dumper = new dumpUtils.DumpDatadbhject () !
Java Imports dumper .dumpDatathject (smo, "Successful Response™)
Promoted Properties out.fire (swo) ;
___d. Click on the output terminal of the Callout Response of getDelayedQuote and drag a wire to
the input terminal of the CustomMediation3 primitive
i@ ; ol
Callout Response CuskamMediation? Input Response
getDelayedQuote, ., getDelavedQuote, .,
=
CustomMediation Stopl
___e. Click on the output terminal of the CustomMediation3 primitive and drag a wire to the input
terminal of the getDelayedQuote Input Response
: P ey |
i@ ] —— " o
Callout Response CuskormMediations Input Response
getDelayedQuote, .. getDelayedQuote, .,
=
CustomMediation topl
__f. Save all work (File = Save All or Crtl + Shift + S)
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Part 5: Assemble the module

In this section of the lab, you will assemble the unModeledFaultTest Module, wiring an export to targets and
define an SCA interface for the business process. As part of the assembly process, the appropriate
deployment code will also be generated in preparation for running the business process as a service
component on WebSphere ESB Server.

1. The Mediation Flow Component needs to be added to the assembly diagram and connected to the
Web service it calls.

__a. Inthe Business Integration view, expand the UnModeledFaultTest mediation module double-
click the mediation module assembly (‘=) Assembly Diagram y to ooen it with the assembly editor

___b. An empty assembly editor for the UnModeledFaultTest mediation module is opened

__c¢. Inthe Business Integration view, expand the UnModeledFaultTest - Mediation Logic -
Flows; select UnModeledFaultTestFlow mediation flow and then drag it over the assembly
editor’'s canvas as shown below:

*UnModeledFault Test - Assembly Diagram X

A Physical Re... | — whl -
= Eﬂlgifffa| ==

TE‘J- Curnplkils

% StockQuoteServiceEAR.

f:‘,]- StockQuoteServicesweb

Ellg UnModeledFault Test

----- ?E;l Azsembly Diagram

----- & Dependencies

EI’E Mediation Logic

&5 A
2 Flows | ._’_‘_,....--"?

------ fb UnModeledFaultTestFlow -
[+ £ Data Tvpes
- Inkerfaces
i Mapping

- % web Service Ports

-

—

Palette

@ &

—

L ]
() T, UnModeledraultTestFlaw .1
-

__d. Inthe Business Integration view, expand the UnModeledFaultTest - Interfaces; select
StockQuoteService an then drag it over the assembly editor’s canvas
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Ty
i = O ?éﬁ *UnMaodeledFaultTest - Assernbly Diagram &2 = O
= #Be D | == e 4# Component Creation E |
= i
L= Dumptis ” Select the bype to create:
% StockuoteSeryiceEAR u
:':J StockfuateServiceWweh z L Companent with no Implementatian Type
: [1-] . .o
=52 UnModeledFault Test c * Export with no Binding
..... %) hssembly Diagram ” "fE-EExpnrt with Web Service Binding
..... 55 Dependencies = Impork with no Binding
[]f—'i Mediakion Lagic FImport with Web Service Binding
'-J‘_:L‘«‘ Data Types
=T Interfaces et
(T stackQuateService ]
..... & Mapping
F- % Web Service Ports
[:‘:?:] a4 I Cancel

___e. Select Import with Web Service Binding from the ‘Component Creation’ dialog and click OK
___f. The ‘Web Service Import Details’ panel pops up. Complete these steps:
1) Ensure the radio button for ‘Use an existing web service port’ is selected

2) Click the Browse button for ‘Port’ filed and select the ‘StockQuoteService’ from the port
selection panel

4= StockQuoteServiceImport1 Web Service Import Details

[F Ilse an existing web service pu:urt]

Part: I StockQuoteService - Browse |

i~ Generate a new web service definition and implementation

This will launch J2EE taals ko help build and configure waur service,
This option is only recommended for adwvanced users,

" Do not specify a web service port: at this time

Cancel |

3) Click OK

___g. Wire the UnModeledFaultTest reference to the StockQuoteServicelmportl as shown below:

(T ﬂUnMndeledFaultTestFluw 1.1 @® @& stockQuoteServiceImport 1

__h. Right click UnModeledFaultTestFlow mediation flow and select Generate Export - Web
Services Binding from the context menu

1) Select ‘soap/http’ from the ‘Transport Selection’ panel

2008 May, 12 IBM WebSphere Enterprise Service Bus 6.1 — Lab exercise Page 20 of 34

WESB UnModeledFaults Lab



© Copyright IBM Corporation 2008. All rights reserved

+= Transport Selection

Select transport For SkockQuoteServiceExpaorkl

snap/htkp
soap/ims

(7) (] 4 I Cancel

2) Click OK

___i. The final assembly diagram should look like in the picture below:

—- G .
~ T StockQuoteServiceImpart
(3] ﬁ!: StockOuoteServiceEXporty (1) B UnModeledFaulk TestFlow 1.1 © & Q P

__j. Save all work (File > Save All or Crtl + Shift + S)

2. OPTIONAL: If using a host or port other than localhost:9080 on your test system, complete these
steps to modify the destinations that are assumed in the imported code.

__a. Inthe Business Integration view, expand ‘UnModeledFaultTest - Web Service Ports’, right-
click on StockQuoteService and select Open With - WSDL Editor from the context menu

e oicn R AR )
TD‘J- Curnplkils
i G StockiJuoteServiceEAR.
e :?‘J StockQuoteServiceMieh
E| 12 UnModeledFault Test
------ E_E,'J Assembly Diagram
----- l-.:l,,_, Dependencies
75 Mediation Logic
= Data Tvpes

= |1_|

Interfaces

r |5t|:|ckQuu:uteServin:thtpPDrt

Cipen With d = @Interface Editar
Show Files =) Text Editor

fdd To Favarites A#5WSDL Editor
¥| ¥ML Editor

1) In the WSDL editor, select the StockQuoteService and then the ‘General’ tab under
properties view
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25 StockQuoteServiceService [

= StockQuoteService % getDelavedOuote
http:/ flocalhost:3081/3ka,.. C+linput
) <1 autput

L LI PR P P | P

2) Update the address (Ex:- <HOSTNAME>:<PORT>) to match your environment.

w\lﬂmhlems Servers = = H)
[General | > port
Drocumentation Mame: StockQuoteservice|
Al Einding: StockQuoteserviceSnapBinding |z|
Address: [ http:/flocalhost: 3081 fStockQuoteServiceWeb/services ! StockiQuoteService ]
Protocal: S0AP E3

3) Press Ctrl+S to save. Close the WSDL editor.

__b. Inthe Business Integration view, expand ‘UnModeledFaultTest - Web Service Ports’, right-
click on StockQuoteServiceExportl_StockQuoteServiceHttpPort and select Open With -
WSDL Editor from the context menu

1) In the WSDL editor, select the StockQuoteServiceExportl_StockQuoteServiceHttp and
then the ‘General’ tab under properties view

2) Update the address (Ex:- <HOSTNAME>:<PORT>) to match your environment

w\wublems | Servers| ¥ = 0|
[General | L port
Documentation Marne: BhockunteServiceExport 1_StockQuoteServiceHEpPort
A Binding: StockQuoteServiceExportl _StockQuoteServiceHtkpBinding E
Address: [ http: /flocalhost: 9081 JUnModeledFault TeskWeb)'scafStockiGuoteServiceExport 1 ]
Pratocol: S0AF [+]

3) Press Ctrl+S to save. Close the WSDL editor.

___c. Inthe Business Integration view, expand the UnModeledFaultTest mediation module double-
click the mediation module assembly ("?& Assembly Diagram y 1o open it with the assembly editor

1) Select the StockQuoteServicelmportl import on the Assembly Diagram and select the
‘Bindings’ under the Properties view

2) Update the address (Ex:- <HOSTNAME>:<PORT>) to match your environment
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Binding
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& Import: StockQuoteServicelmport! (Web Service Binding)

© Copyright IBM Corporation 2008. All rights reserved

SErvers

Address; [:‘lttp:,I',I'|l:|l:a||‘|l:|5t:'5"]81,I'StDl:kQLIDtESEWiI:E'I.I'I.I'E|:|,I'SErViEES,I'StDCkQUDtESEWiCE ]

Park: StockQuoteservice

Service: StackQuoteServiceService

Mamespace: |http:ffexample.com

Browse, ..

___d. Press Ctrl+S to save the assembly diagram. Close it.

__e. Open the J2EE Perspective (Window - Open Perspective - Other...> J2EE). Click on OK.

1) In the Project Explorer view, expand StockQuoteServiceWeb - WebContent - wsdl >
com -> example; right-click on StockQuoteService.wsdl and select Open With &> WSDL

Editor from the pop-up menu

El:":‘J StockJuoteServiceWeb

----- fu Security Editor
----- @y, weh Diagram
[l Web Site Navigation
f% Java Resources: JavaSource
== WebContent

#-(2 META-INF

H-C2 theme

-2 WEB-INF

- wsdl

E-E= com

kiuaoke

28 Deployment Descriptar: StockQuoteServiceweb

Service, wsdl

2) In the WSDL editor, select StockQuoteService and then the ‘General’ tab under properties

view

3) Update the address (Ex:- <HOSTNAME>:<PORT>) to match your environment

P
Praoblems W\Sewers
|

Snippets

o

VEE

[ General

Daocumentation

Extensions

Database Explorer
E: port
Marne: 'ﬁtu:uckQuu:uteService
Einding: StockQuoteServiceSoapBinding
Sddress:
Frotocal: 08P

htkp: fflocalbiost; 9051 fStockiQuoteServiceweh) services StockQuoteService

-]

7]

___f. Press Ctrl+S to save. Close the WSDL editor.
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Part 6: Add the modules to the server
In this part of the lab, the Mediation Module is published to the WebSphere ESB Server 6.1 test server.
1. Start the WebSphere ESB Server if not started and add modules to the server

If using a remote testing environment, follow the instructions in Task: Adding remote server to
WebSphere Integration Developer test environment at the end of this document, to start the
remote server.

If using a local ESB Integrated test environment, complete the steps below:

___a. Open Servers View.

___b. Select the ‘WebSphere ESB Server v6.1" and right-click to select “( o ) Start” from the context
menu

- "y
Build Activities | Properties | Problems MDnsule s b G (B | =l = 0O

Server Skatus Skate

0 ‘WebSphere ESE Server v, 1 E:[ Stopped Republish
& WwebSphere Process Server vé.1 [ Stopped Republish

___c. This will take some time. Wait for the server to start and the Server serverl open for e-
business message.

2. Add the projects to WebSphere ESB Server. In the servers view, right-click on WebSphere ESB
Server v6.1 and select ‘Add and Remove Projects...” from the context menu

Note: WebSphere ESB server that is being used is configured with an ESB profile that is part of the
installation and not part of the workspace. Therefore, if there are any projects deployed to the server from
a different workspace, there may be some naming conflicts or other problems. If this occurs, open the
Administrative Console and stop/uninstall those projects before adding these projects. This should avoid
any potential errors.

___a. Click the Add-AlI>> button to move all projects to server
___b. Click Finish

___¢. Wait for the deployment to finish.
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Part 7: Test the mediations using the Web services explorer

1. Inthe Business Integration perspective, expand ‘UnModeledFaultTest - Web Service Ports’

= O

b

Business Integration

= #e D

'[E‘J Dumpltils

i %5 StockQuoteserviceEAR,
I StuckQuuteSerwceWel:u
232 = UnModeledFaulkTest
f;l Aszembly Diagram
----- @E Dependencies
#-1 Mediation Lagic

= Data Twpes

& Interfaces

...+

..... 2o Mapping
=¥ weh Service Ports
------ @ StockQuokeService

Skocks JuoteServiceExportl ! .t|:||:I::_IZ::_Iu|:|I:Ee'E.Eer'-.-'iu:thI:pF'::urt

2. Right-click on StockQuoteServiceExportl_StockQuoteServiceHttpPort and then select ‘Web
Services > Test with Web Services Explorer’ from the context menu

3. The Web Services Explorer opens the UnModeledFaultTest_StockQuoteServiceExportl.wsdl
file as shown below:

Web Services Explorer

S5 Mavigakar Bikions

5 WSDL Main 3 o )
= 2 file:{C:fLabfiless 1 fWESB/URM | <% WSDL Binding Details
El- D‘_‘f Stu:u:kQuu:uteSerwceExpDrt

Shown below are the details for this SOAP <binding > element, Click on an operation to Fil
in its parameters and invoke it or specify additional endpoints.
- Operations

Docurnentation
getRealTimeQuote | --

[getDeIagedg;uote --]
*  Endpoints Add Remove

r -

[T httpefflacalbost: 9081 jUnModeledFaulk TestWeb scafStockQuakeServiceE xport 1

4. Click the ‘getDelayedQuote’ entry

___a. Input IBM as the symbol
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= getDelaveduote

symbal string I~ niil?
IEM

E Reset

___b. Click the ‘Go’ button

___c. Verify that the result is shown in the Status section of the Web Services Explorer. The the
resulting stock quote value may differ.

I Status

Source
= pgetDelayedQuoteResponse

getDelayvedQuoteReturn (Float): 116,35

___d. Look in the console log at the SMO that was dumped as part of the Custom Mediation. Verify
that it went down the ‘Successful Response’ path. You should see the following at the
beginning of the message.

O HEHHBHEBHEEY Start Datadthiect Dump HESHHEHHEHHE

0 Uzer Supplied Comment = Jucceszszful Response

___e. Inspect the rest of the SMO and see that the response had the stock value returned.

| Property: body
| ————| ##f#f Srart DO Dump #Hi#
| ————|Type -> getlelayeduoteResponse
| ————| Property: paratmeters
| ———=|————| ### Start DO Dump H#H
| -——=1|Type -> getDelayedQuoteResponse . type
| ————| Property: getlhelayvediuoteReturn
e | Type: Float
| ————1 Value: 116.35
| ————|-———| ### End DO Dump ###
| ———— | ### End DO Dump #H##
| ### End IO Dump H##
#EHEEESHHREE End  Datacbiect Dump SES#SHEEEHEH

LT T T o T T T s T T B T T
|
|
|
|

5. Test the flow with an unknown symbol.

___a. Input MYIBM as the symbol you want to get a quote for

* getDelayvedQuote
symbal string [ nil?
MY TEM

"f Reset
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___b. Click the ‘Go’ button

___c. The status window should inform you there is nothing to display:

I status

Source
There is nothing ko be displayed in the form view, Please switch to the source view

for the SOAP request and response,

___d. Look in the console log at the SMO that was dumped as part of the Custom Mediation. Verify
that it went down the ‘Modeled Fault’ path

O HESFESHAHEESE Starc DataCbiject Dump HESSHHSHEEEE
0 Tser Supplied Comment = Modeled Fault Taken

___e. Inspect the rest of the SMO and see that the response returned the modeled
UnknownSymbolException

| FProperty: bhody

| ————| ### Start DO Dump HEH

| =————| Type -> DhknowndvyvibolException

| ==—=—=| Property: fault

| ————| ————| ### Start DO Dump HFH

————| Type -> DahknownSvbolException
————|Property: message

————] Type: String

————] Value: Unknown symbol: HYIEM
| ———=|————| ### End DO Dump #H##

| ————| ### End Do Dump H#H

| #£# End DO Dump #Hi#

HESSSSEEEEEY End DataChiject Dump HESESSSSSEEH

L e e e T I 5 o T T T T
|
|
|
|

___f. The soap envelope is also available in the status window (bottom window) by clicking on the
Source link. Click on Source

I status

e
Source -

___g. Maximize the Status window by double-clicking on the Status bar and inspect the Soap
Response envelope. The modeled UnknownSymbolException fault should be seen.
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- S0AP Request Envelope:

<?aml wersion="1.0" encoding="UTF-8" 7=
- «<soapenv:Envelope smins: q0="http:/fexample.com"
#mins: soapenv="http://schemas.xmlsoap.org/soap/envelopes"
smins: ssd="http:f fvwww w3 .org /2001 5MLSchema”
smins: wsi="http:f A www . w3.org/ 2001/ XMLSchema- instance"s

- «<soapeny: Body:
- gl gethelayedQuote=
zsymbol=MYIBM</symbal=
=/q0: getDelayedQuate=
</soapenv: Body=
=/soapenv: Envelopes=

+ SOAP Response Envelope:

— ZsOapeny. Body=
- <soapenv:Fault=
=faultcode
smlns: pg229="http:/ fexceptions.example.com"=
p829:UnknownSymbolException</faultcode =
- «faultstring=
I CDATA[ Unknown symbol: MYIEM ]]=
= /faultstring=>
- «=detail encodingStyle=""=
- <exmUnknownSymbolException smins:ex="http:/ /exceptions.example.com"
=3 type="ex:UnknownSymbolException"=
zmessage=Unknown symbol: MYIBM</message>

___h. Double-click on the Status window again to restore the Web Services Explorer window
6. Test the flow with a symbol containing invalid characters to test the unmodeled fault case

___a. Input @IBM as the symbol you want to get a quote for

- getDelayedQuoke
symbol string I ril?
@IEM

a0 Reset

___b. Click the ‘Go’ button

___C. The status window should have nothing in it:

1 status

Source

= getDelayedQuateResponse

___d. Look in the console log at the SMO that was dumped as part of the Custom Mediation. You will
see a “BadSymbolException”. In addition, verify that it went down the ‘Unmodeled Fault’ path
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O HESHSESHAHEESE Start DataCbject Dump HESSHESHSEEE
0 User Supplied Comment = Tn-Modeled Fault Taken

___e. Inspect the rest of the SMO and verify that the entire message was included in the response.
You should see that the body has the invalid symbol you entered.

O | Property: bhody

O | ————| ### Start DO Dump HHEH

0 | —-———| Type -» getDelayedluoteRequest

0 | ————| Property: parameters

O |————|————| #fi# Startc DO Duamp HHFH

0 |-———|-——-|T¥pe -» getlelayedluote . ty¥pe

0 |-———|-————| Froperty: svubol

O | === === Type: 3tcring

O |————| ———| Value: @IBM

O | ————|————| ### End DO Dump H#H

O | -———| ### End DO Dump ###

O |### End DO Dump H##

O HESHSEREEEEE End  DataCbject Dump S#Ssdgdsssss
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What you did in this exercise

In this lab, you saw how to handle an unmodeled fault within a mediation flow. External services are not
typically change controlled by their users and thus may change without the user of the service being aware.
You saw how unmodeled faults (ones not specified in the WSDL interface) can be handled in the mediation
flow when this occurs. You used the new unmodeled fault terminal in order to call a Custom Mediation that
printed out the Service Message Object and then Stopped. Another option is to use an Event Emitter to log
the fault.
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Solution instructions
1. Import Solution Project Interchange file.

___a. With a blank workspace in WebSphere Integration Developer, Go to File  Import - Project
Interchange

___b. Click on top Browse button and navigate to
<LAB_FILES>\importtWESB_UnModeledFaults_PI_solution.zip

___C. Click Finish button
2. OPTIONAL: If testing on a remote system, complete Step 2 in Part 5: Assemble the module

3. Start with Part 6: Add the modules to the server
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Task: Adding remote server to WebSphere Integration
Developer test environment

This task describes how to add a remote server to the WebSphere Integration Developer test environment.
This example uses a z/OS machine.

1. Define a new remote server to WebSphere Integration Developer.

___a. Right click on the background of the Servers view to access the pop-up menu.

___b. Select New > Server

Build Activities | Properties | Problems | i Servers 22 £ 0 =0
Server Stakus Skate
Websphere Process Server v6.1 ZE\ Stopped Republish

New b5 Server

r s

___c. Inthe New Server dialog, specify the remote server’s host name, <HOSTNAME>.

___d. Ensure that the appropriate server type, ‘WebSphere Process v6.1 Server’ or ‘WebSphere
ESB v6.1 Server’, is highlighted in the server type list

QNew Server @

Define a New Server
Choose the type of server to create

Server's host name: | mvsicodrtp.raleigh.ibm, com| w

Select the server type:

==+ IBM
WebSphere ESB vE. 1 Server
ﬁ WebSphere Express w5, 1 Server
WebSphere Process v6. 1 Server
|'§—__,5' WebSphere w5 Server Attach
ﬁ WebSphere v5. 1 Server
WebSphere v&.0 Server
WebSphere va. 1 Server

#-[= Other

View By: | Vendor 4
Description: Runs service projects on the WebSphere Process w6, 1 Server.

Server runtime: | WebSphere Process Server va, 1 || Installed Runtimes. ..

(Z) Mext = ] [ Finish l [ Cancel

___e. Click Next.

2008 May, 12 IBM WebSphere Enterprise Service Bus 6.1 — Lab exercise Page 32 of 34

WESB UnModeledFaults Lab



© Copyright IBM Corporation 2008. All rights reserved

__f. On the WebSphere Server Settings page, leave the radio button for SOAP selected, changing the
SOAP connector port to the correct setting (<SOAP_PORT>). If security is on in your server,
check the box for ‘Security is enabled on this server’ and input <USERID> for the user ID and
<PASSWORD?> for the password.

€0 Mew Server
WebSphere Server Settings - 9
Input settings for the new WebSphere server, ’_‘
1

Server connection type and admin port

() RMI (Designed to improve communication with the server)

(23 50AP (Designed ko be more firevall compatible)
SO0P conneckor port: | 5830

Security is enabled on this server

Current active authentication settings:

User [D; szadmin
Password: [TITTY
Server name: sssr01d

Server bype
(=) BASE, Express or unmanaged Mebwork Deployment server

() Network Deployment server

Click this button ko detect the server bype,

7 < Back ” Next = ” Finish H Cancel

___g. Click Finish

___h. The new server should be seen in the Server view.

Build Activities | Properties | Problems | 415 Servers 22 £ : =0
Server Status Skate
wWebSphere Process Server wb,1 = Stopped Republish
wehSphere Process 6.1 Server @ mvsiood.rtp raleigh.bm.com B Stopped Republish

2. Start the remote server if it is not already started. WebSphere Integration Developer does not
support starting remote servers from the Server view

___a. From a command prompt, telnet to the remote system if needed:

‘telnet <KHOSTNAME> <TELNET_PORT>’
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User ID: <USERID>
Password: <PASSWORD>
___b. Navigate to the bin directory for the profile being used:
cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin
___¢. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

___d. Wait for status message indicating server has started:

ADMU32001 : Server launched. Waiting for initialization status.

ADMU30001: Server cllsrOl1l open for e-business; process id is 0000012000000002
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